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Module 1: Software Installation and System Set Up

Installation and Setup

Training Resource Requirements
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Please have a PC workstation available for each student attendee with administrative rights to
install software and hardware drivers, USB or Parallel port enabled, and password to reboot
the system. If passwords and admin rights are prohibited to students and trainer, please have a member
of your IT staff present at the start of the first day of training to assist with the training software
installation.

The Designer training course offers hands-on lab assignments that require an additional
method of soft-proofing the VIPP resource output prior to printing. Each student PC should
be equipped with one of the following: Adobe Acrobat Distiller 8.0.1 or later, Xerox FreeFlow
VI Explorer, Xerox FreeFlow VI Designer, or Xerox FreeFlow VI PDF Originator.

Lab resource files (Proform Designer software installation, Proform Designer training dongles,
sample lab data, lab image files, lab fonts, lab text files) will be supplied by the Lytrod Software
Training Instructor.

Soft-proofing using Adobe Distiller will also require the installation of the FreeFlow VI Interpreter
(VIPP Core Interpreter installation CD) on the workstation PC. It is not required to have a VIPP
license on the workstation to install VIPP for *.pdf proofing.

Designer Installation System Requirements

The minimum PC system requirements to run Designer are as follows:

*  Microsoft Windows operation system version 95, 98, 2000, NT [ver. 4.0 and above],
Millennium Edition [ME], XB or Vista

* PC user rights for periodic access to and editing of system registry during software operation
e 256 MB of RAM

* 1 GB hard disk space

* CD-ROM Drive

* Two-button mouse

 Parallel or USB Port enabled (for license dongle)

e Pentium IV 2.8Ghz/AMD Athlon 2800 MHZ or faster processor (recommended)

e 17” Super VGA monitor or larger (recommended)

* Internet access and software *.exe download rights for Automatic Software Update Service
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Installing Designer

Installation of the software requires PC administrative rights that enable the installation of
software, access to the system registry, and installation of a device driver for the dongle.

% To install Designer (parallel port dongle)

* Attach the parallel port dongle to the system prior to the initial boot up before installing the
software.

* Insert the installation CD to the CD ROM drive. An automatic setup menu will appear.
Follow the directions on the menu. International versions of the software will offer the
installation in the English, French, German, Spanish, or Italian languages.

< To install Designer (USB dongle)

* Insert the installation CD to the CD ROM drive. An automatic setup menu will appear.
Follow the directions on the menu, but do not attach the USB dongle during the software
installation. International versions of the software will offer the installation in the English,
French, German, Spanish, or Italian languages.

e Reboot.

* Attach the USB dongle and use the Windows New Hardware Device Wizard (should
automatically appear in WinXP or later O/S) to find a driver for the USB dongle.

Double-click the Designer icon on the Windows desktop or select the Designer product from
the Windows Start, Programs menu.

What Printer are You Designing Forms For?

The first time Designer is launched a prompt will appear requiring the selection of a type of
printer and forms language.

This training course requires output to PostScript VIPP. Please select the following:
* Printer: PostScript (Color)
* Forms Language: Xerox FDL

The International Defaults check box will enable international units of measurement and
paper sizes. If this box is checked, Designer will automatically default to A4 as paper size,
millimeters as page size unit, centimeters for all rulers, and 40 channels for OMR.

VA Northern Indiana Health Center / Lytrod Basic VI Training / July 14-15, 2009 / DO NOT DUPLICATE / Internal Use Only © Copyright 2009 Lytrod Software, Inc.
2



Module 1: Software Installation and System Set Up Lytrod Software Designer User Training Manual

‘What Printer Are You Designing Forms For?

A resource setis being used that doesn't define the type of
printer that the forms are to be designed for. Please specify
this information now so that wour forms designing can be
tailored to the capabiliies of your grinter.

Resource Set |[FRO-FORM

Frinter: |

[ Intemational Defaulis
Forms Language
’7 @ Xerox FOL  IBM OGL

Ok I Cancel |

Automatic Software Update Service

Software licenses current on the annual maintenance subscription or Xerox internal licenses

are able to download software updates through the Internet. Software updates are available
periodically, about every 30 days.

< To enable the automatic software update service
1. Go to the Edit menu and select Preferences.
2. Access the System tab.

3. Check the Enable WEB Based Software Updating check box.
4. Click OK.

[Preferences 1S
System | Page Layour| Design | Dote. | 0MA | Cupun| Tats |

Gonersi Eralessrcos.

I Creeto Backup Fike

I asoSove [T =] Mmwies

™ Display Elapsed Time

FpcareFilg L [l =] Essas

I Fasict TreaTypa Fores

I~ Ranisrict Sesad T [na kntilogoinmage)

[T gt 1o Lt Tiest Dirgection

¥ Enabie WEE Based Sotwars Updnting

_ox | o |

% To manually update the software
1. Close all form pages or jobs.

2. Go to the Help menu and select Internet Software Update.

Help
Tip of the Day...

Help Topics... F1

Update Software License..,
Abaut Proform Desigrer...
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Set Up PDF Proofing of VIPP Jobs

Enabling Adobe Distiller to work with the VIPP Interpreter will allow the proofing of VIPP
output to a *.pdf. Designer can output a job directly to a VIPP enabled Adobe Distiller,
auto-launching the application for immediate proofing results. If the job is acceptable after
viewing the proof, VIPP \XGFC directory printer resources will also need to be generated from
Designer to submit the job into production.

Loading the FreeFlow VI Interpreter and editing the Adobe start up file is not necessary if FreeFlow VI
by PDF Originator (VIPP Thin Printer) is loaded on the local system.

FreeFlow VI Designer (VIPP IDE) cannot be licensed and installed on the local system prior to
j installing the FreeFlow VI Interpreter (VIPP core) and enabling Adobe Distiller to PDF proof VIPP
jobs.

Install Adobe Distiller and VIPP

Adobe Distiller and VIPP must first be installed on the PC workstation. A VIPP license for
the workstation is not required for PDF proof printing.

1. Install Adobe Acrobat with Distiller.
2. Uninstall FreeFlow VI Designer (VIPP IDE).

3. Install the FreeFlow VI Interpreter CD. This will automatically create XGF and XGFC folders on the
C: or otherwise specified drive.

VIPP-enable Adobe Distiller

The Adobe Acrobat Distiller startup file must be edited in order to proof VIPP applications.

1. Open the Adobe Distiller Startup file in Notepad. The location & filename will vary depending
on the version of Distiller installed.

Anticipated Distiller Startup File location & filenames

Adobe Distiller 5.0 C:\Program Files\Adobe\Acrobat 5.0\DistlIr\Startup\example.ps

Adobe Distiller 60 C:\Program Files\Adobe\Acrobat 6.0\Distllr\Data\distinit.ps
Adobe Distiller 70 C:\Program Files\Adobe\Acrobat 7.0\Distllr\Data\distinit.ps
Adobe Distiller 8.1 C:\Program Files\Adobe\Acrobat 8.0\Acrobat\Data\distinit.ps

2. Add the following lines at the end of the file:
* (Loading VIPP from C:\\xgf...) print flush
o (C:\\xgf\\src\\xgfdos) run

3. Save the file and close it.

Please note the previous instructions use the suggested default drive letter and path for the installation
f of Acrobat Distiller and the VIPP Interpreter. The drive and path may vary.
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lf Adobe Distiller 8.0.x contains a feature that will not allow Designer to create a PDF file. If Distiller
8.0.x is currently installed, use Adobe's free update service to obtain the latest relase of version 8.

Prepare Acrobat Auto-launch

Acrobat Distiller is a utility within the Acrobat suite that supports the generation of *.pdf
files. Distiller preferences can be set to auto-launch Acrobat to view the newly generated

* pdf.

<+ To set Adobe Distiller Preferences to auto-launch Acrobat

1. Launch Adobe Acrobat Distiller.

2. Go to the File menu and select Preferences.
3. Check View PDF when using Distiller and click OK.

["1Azk for PDF file destination

[#]Wiew PDF when using Distiller

Log Files
[T] Delete Log Files for successhul jobs

or Document Defaults.

These preferances control the Distiller application. For Adobe POF Frinter
[ ] satings. nght-click the Adobe POF printer and choose Printing Preferences

| Preferences - Acrobat Distiller o LE]
Startup Alerts
e ok |
[] Notify when Walched Folders are unavailable =
[ I Notity when Windows TEMP folder is nearty full Cancel
Output Options Help
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Pre-Training Adobe Distiller VIPP Proofing Setup Instructions

The Designer training course offers hands-on lab assignments that can use a viewable *.pdf
method of proofing the finial VIPP resource output for each application built. If FreeFlow VI
PDF Originator (VIPP Thin Printer), FreeFlow VI Designer, or FreeFlow VI Explorer is
installed on the local workstation, the following set up and software is not required.

The local workstation will need to have the following installed:
* Licensed Adobe Acrobat with Adobe Distiller (not supported in version 8.0.x )

* FreeFlow VI Interpreter (VIPP Core Interpreter installation CD)

Install FreeFlow VI Inferpreter
1. Uninstall FreeFlow VI Designer if it is installed on the workstation.
2. Install the FreeFlow VI Interpreter on the C:\ of the PC workstation (no license file is necessary).
 Insert the FreeFlow VI Interpreter Install CD.
e The install wizard will guide you through set up.

e Select No when asked for the license file and complete the installation.

Install Adobe Distiller
3. Install a licensed Adobe Acrobat Distiller.

4. Edit Distiller startup file in Notepad to map to FreeFlow Interpreter source file. Please follow the
appropriate steps below according to the version of Distiller that you are using

Distiller 5.0

\Adobe\Acrobat 5.0\Distillr\Startup\Example.ps
Distiller 6.0

\Adobe\Acrobat 6.0\Distillr\Data\distinit.ps
Distiller 7.0

\Adobe\Acrobat 7.0\Distillr\Data\distinit.ps
Distiller 8.1

\Adobe\Acrobat 8.0\Acrobat\Data\distinit.ps
Distiller 9.0

\Adobe\Acrobat 9.0\Acrobat\Data\distinit.ps

Right click and open the file in Notepad to add the following lines at the end of the file:
(Loading VIPP from C:\\xgf...) print flush
(C:\\xgA\src\\xgfdos) run

lf Adobe Distiller 8.0.x contains a feature that will not allow Designer to create a PDF file. If Distiller
8.0.x is currently installed, use Adobe's free update service to obtain the latest relase of version 8.
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* Using Windows Explorer, find the Adobe Distiller file to edit per the version of Acrobat
installed on the system.

* Open the file in Notepad and key in the edits.

* Save changes to file in Notepad and close the edited file.

Adobe Distiller Preferences
5. Launch Adobe Distiller and edit the Preferences to auto-launch Acrobat.
e Launch Adobe Acrobat Distiller.
* Go to the File menu and select Preferences.

»  Check View PDF when using Distiller and click OK.

x
— Starup Alerts
oK
[+ Motify when YWatched Folders are unavailable

[ Notify when Windows TEMP folder is nearly full Cancel |

i Output Options Help

[ Askfor PDF file destination

[ Ask to replace existing FOF file
[# Wiew PDF when using Distillsr

Log Files
( [~ Delete Log Files for successiul johs ‘

These preferences control the Distiller application. For Adohe PDF Printer
settings, right-click on the Acrobat Adobe PDF printer and choose Printing
Freferences or Document Defaults.

Test PDF Output
6. Launch Adobe Distiller and open C:\xgf\demo\letter.dbf.
e Launch Adobe Acrobat Distiller.
* Go to the File menu and select Open.
e Go the Files of type drop-down menu and select Al files (*.*).
* Go to the Look in drop-down menu and browse for C:\xgf\demo\letter.dbf.

 Select letter.dbf and click Open. Acrobat should auto-launch to show a two page PDF variable
letter.
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XEROX. XEROX.

Monsieur Alain DUPONT Madame Martine BELLEGAMBE
3 1a N chez son copain
3, rue de la zare 12,place dels posie

1034 - Law

1200 - Genéve

Cher Mensiew DUPONT, Chére Madame BELLEGAMBE,

. e Die Welt,in der Sie Joben, Chire Madzme BELLEGAMBE, ist - in Ubersinstimmung mit
Die Welt, in der Sie leben, Cher Monsienr DUPONT, 1st - in Ubereins nung it Threr 'z
Berstaicithoit  smsergenamich - Ihwer Persénlichleit - aussergewohnlich.

der exklusivsten Klasse.

Trembley Bs
lnsivitst sow

Iym, ein Auto

asserzewsinlich
anf das sussergawelmlich hohs M

. ein Autom:

So aussergewshalich wie der Trembley Br

il der exklusivsten Klasse.
I

er Bes klusivitit sow das aussergevdhulic e der t sich der Bag
Vermbeitung, des L, als auch auf dis Sicherheit und die Fabileisnungen erszecht. Verarbenaag, des L, als such suf ie Sicharheit wsd die T sungen ersaecht.
Und, aufdieD: . Lommtein 15 ein Spi Usd, aufdieD. Lomumein st
irgend eines Groscherseellers: Tn 30 Jabren wird Thr Brocklyn immer noch modem und irgend eines Grossherstellers: Tn 30 Jabren wind Thr Brooklm immer noch modem wnd
Ealutiichtig sein. wie e zwel Drittel der seit 73 Jahren produzierten Trembleys heuts noch falurtiichtiz sein, wie s zwei Dritiel der seit 73 Jahren produzierten Trembleys heute noch
sad s
Wir mbchten es Dnen amudglichen, wihrend einigen Stunden die Welt des Trembley Wir méchten s Tinen emiglichen, wihvend sinigen Stunden dis Wekt des Trembley
Brooklyn zu erlebex Brooklyn zu exleben
 wlsien Siase des Woates. Wo und wam i luaea gaeiun it wad 2w s die Iim walirsten Simne des Wertes. Wo und wann dies Thnen genebm it und zwar auf die

angenebmsts, sinfachsts Wei: angenelmste, einfachste s

Wir fahven bet Thnen vor, Thre Welt und unsere Welt begegnen sich. Sie divfen sich dann
davon iberzeugen, dass der Brooklyn i Einklang mit Thven persénlichen Wertmasestiber
et pos

falen bei Tanen vor, lwe Welt und unsere Welt bezeznen sich. Sie diirfen sich dann
m lber dass dex Brookly mit Thren persanlich e

Esgeniizt, beiliezend, v Es geniiat, beiliezend Wi werd

wm alles Kimmenm um alles kiimmem

Lassen Sie sich therraschen. Wir werden Iimen die Aufmerksambeit widmen, die Sie Lassen Sia sich bamaschen. Wir werden Tanen die Aufmerksamsit widmen, dis Sia
verdienen verdienen.

Germe enwarten wir [hre J verblsibes 5 Grisssen.

Germe erwarten wir [re Antwort und verbleiben inzwischen mit freundlichen Gritssen.

MAMAGRIG DIRECTOR MANA “G]&'{I%BDI;_E(TOR

letter.pdf page 1 letter.pdf page 2

N FreeFlow VI Designer (VIPP IDE) can be installed and licensed after the installation of the FreeFlow
(2 VI Interpreter and the setup of Adobe Acrobat Distiller for VIPP PDF job proofing.
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